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Arbeiten mit der Render View
Die Render View selbst hat eine Reihe von Funktionen die einem das Arbeiten und das Ausrendern 
sehr erleichtern.

Repeat Last Render
Dieser Button wiederholt einfach, den gleichen Render von der gleichen Kamera mit der man als 
letztes gerendert hat. Ungleich zu dem Button „Render Current Frame“ auf der Status Line, muss 
daher nicht vorher bestimmt werden. D.h. man kann weiter in Maya arbeiten und immer wenn 
man zurückkommt zur RenderView wird die gleiche Kamera ausgerendert.

Render Region/Snapshot

Mit LMB kann man eine rechteckige Auswahl  auf dem Image 
Display Bereich selektieren. Drückt man den Button wird nur 
diese Region gerendert. Um die Auswahl wieder aufzuheben 
muss man einmal kurz LMB klicken.

Dies benutzt man wenn man Details korrigieren möchte ohne 
viel Zeit zu verschwenden  das ganze Bild auszurendern.

Wenn man noch keinen Render von der aktiven Perspektive 
gemacht hat, so kann man auf Snapshot klicken und man be-
kommt einen render von der Szene im Wireframe-Modus. Man 
kann nun ohne raten eine genaue Region auswählen die man 
ausgerendert haben möchte. 

Interactive Photorealistc Render (IPR)
Man benutzt das IPR ist das man schnell einen Überblick bekommen kann wie Lichter und Farben 
wirken. Mit dem IPR kann man eine Render Region auswählen. Der Unterschied zwischen Render 
Region und IPR, ist das man nun Materialeigenschaften verändern kann und die Veränderungen 
werden sofort in der Render View übernommen. 

Wenn man das IPR verwendet, sollte man die Qualität der Rendering Engine auf sehr niedrig 
stellen dies Erlaubt dem IPR sehr schnell die Veränderungen zu übernehmen. Man kann für das 
IPR-Rendering nur MayaSoftware und Mental Ray verwenden.

Um einen IPR-Render zu erzeugen klickt man auf Repeat last IPR Render und selektiert die Region 
mit der man arbeiten möchte.

Render Settings
Öffnet die Render Settings.

Die RenderView Icons

Beispiel von einem Snapshot und anschlie-

ßender Render Region
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Display RGB/Alpha/Real Size
„Display RGB“ zeigt das gerenderte Bild in Farben an, „Display Alpha“ zeigt den Alpha Kanal an.

Man kann auf dem Bild mit den normalen Camera Kontrollen Zoomen und bewegen. Möchte 
man ein unskaliertes Bild haben, klickt man einfach „Display Real Size“.

Keep Image /Remove Image
Wenn man verschiedene Werte verändert, möchte man machmal einen Vergleich zwischen vorher 
und nacher machen.

Klickt man auf „Keep Image“, so wird das Bild temporär abgespeichert d.h. schließt man Maya so 
werden alle gerenderten Bilder wieder entfernt. Nachdem man ein Bild temporär gespeichert hat, 
kann man nun etwas in der Szene verändern und nochmal rendern. Mit dem Scrollbalken am un-
teren Rand vom Fenster kann man von Bild zu Bild springen.

Möchte man ein Bild nicht mehr sehen so klickt man Remove Image und das aktuelle Bild wird 
entfernt.

Wenn man sich notieren möchte was man eigentlich verändert hat zwischen den Bildern, so kann 
man mit RMB auf die Icons Klicken und „Keep Image with Comment“ auswählen. Der Kommen-
tar wird dann unten bei den Renderinformationen angezeigt.

Render Diagnostics
Die Render Diagnostics öffnet das Output Fenster und zeigt die letzten Meldungen der Render 
Engine an. Dies braucht man wenn z.B. Fehler beim ausrendern auftreten.                                                                

Render Engine
Das Dropdown Menü lässt einen die Render Engine auswählen ohne die Render Settings dafür 
zu öffnen. (Insbesondere ist dies nützlich, wenn Objekte nicht angezeigt werden beim ausrendern. 
Benutzt man z.B. ein mia_material_x so kann Maya Software die Geometrie nicht rendern dann 
kann man hier überprüfen ob man auch mit Mental Ray rendert.)

IPR Controls
Die IPR Controls sind nur dann aktiv wenn man einen IPR Render macht. Der Pause Button 
pausiert den IPR Render, d.h. man kann veränderungen machen ohne das der render sofort neu 
ausgerechnet wird. Daneben ist eine anzeige wieviel zwischenspeicher für den IPR render benötigt 
wird. Und der Rote Knopf beendet das IPR-rendering.
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Lighting
In 3D-Umgebungen gibt es eigentlich kein Licht solange man kein Licht der Szene hinzugefügt 
hat. Daher hat Maya ein eingebautes „Default Light“ dies wird verwendet damit man ohne zusätz-
liche Lichter die Szene ausrendern kann. Insbesondere auch damit man überhaupt während dem 
modellieren irgendwas sehen kann.

Sobald man ein Licht der Szene hinzufügt wird dieses Licht automatisch ausgeschaltet. In manchen 
Fällen gibt es jedoch Konflikte,  daher kann man das Default Light in den Render Settings manuell 
ausschalten.

Direct Lighting
Im Grunde ist Direct Lighting, jede Lichtquelle die einen Schatten wirft. Alle Lampen in Maya 
sind nachgebildet von den gleichen Licht Typen und Beleuchtungs mittel die verwendet werden 
können für eine Filmproduktion. 

Lichter in Maya erzeugen
Man kann entweder über Create > Lights oder über die Shelf Rendering Lichter in Maya erzeugen.

Die Shelf Icons:Ambient Light, Directional Light, Point Light, Spot Light, Area Light, Volume Light

Jedes Licht hat sein eigenes Light-Icon, in den meisten Fällen kommt das Licht von diesem Punkt. 
Das Light-Icon bzw. die Lichtquelle selbst wird beim ausrendern nicht ausgerendert.

Ambient Light

Licht Typen

Ambient Light
Dieses Licht gibt ein weiches Licht in jede Richtung. Es erzeugt 
daher ein sehr diffuses Licht. Die  Intensität hat daher kaum Va-
rianz. 

Das „Ambient Shade“-Attribut bestimmt das Verhältnis zwi-
schen omidirectionalen und direkten Strahlen. Ein Wert von 1 
entspricht das alle Lichtstrahlen von dem Light-Icon in der Szene 
stammen, damit ist es identisch zu einem Point Light. Ein Wert 
von 0 lässt das Licht von der Lampe an jeder Position im Bild 
identisch stark erscheinen (Dadurch gibt es keine Schatten mehr 
und alles sind nur noch Farbflächen). Per Default ist der Wert auf 
0.45 gesetzt.

Daher hat die Positionierung des Lichts nur einen kleinen Ein-
fluss auf das Licht. Auch kann man keine Decay Rate für dieses 
Licht setzen.

Ambient Lights werden eigentlich nicht verwendet, da es einen 
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sehr flachen Eindruck im Bild erzeugt bzw. mit anderen Licht-
quellen hat man mehr Kontrolle über das Licht. Das Licht wurde 
nur der Vollständigkeitshalber erwähnt.

Directional Light
Dieser Licht Typ ermöglicht die Simulation von unendlich vie-
len parallelen Lichtstrahlen von einer unbestimmten Lichtquelle. 
Daher bietet es sich an Directonal Light zu verwenden für Son-
nenlicht.

Dadurch das die Strahlen parallel von einer unbestimmten Quel-
le kommen, spielt die  Positionierung  des Light Icons keine Rolle.  
Nur die Rotation des Light-Icons hat einen Einfluss auf das Licht.

Möchte man z.B.. Sonnenlicht durch ein Fenster strahlen lassen, 
so muss man die Schatten von der Lichtquelle aktivieren anson-
sten wird der gesamte Raum mit Licht erfüllt. 

Point Light
Die Lichtquelle vom Pointlight ist ein einzelner Punkt und Licht 
strahlt von dem Punkt in alle Richtungen. Daher ist es ein gutes 
Licht um Glühbirnen, Kerzen, LEDs oder ähnliches zu simulie-
ren.

Da alles Licht von einem fixen Punkt ausgeht hat nur die Positi-
onierung einen Einfluss aufs Licht.

Spot Light
Sind Lichter die reale Spotbeleuchtungen aus dem Theater/Film 
simulieren. Ähnlich wie das Point Light entstammt das Licht von 
einem bestimmten Punkt, wird jedoch dann durch einen Kegel 
in die Szene projiziert. Die gängigsten Anwendung für diesen 
Licht Typ sind, Taschenlampen, Scheinwerfer und Spotbeleuch-
tungen darzustellen.

Positionierung und Rotation haben einen Einfluss auf das Licht. 
Darüber hinaus kann man den Öffnungswinkel über das Cone 
Angle Attribut verändern um einen größeren/kleineren Bereich 
zu beleuchten.

Area Light
Dieses Licht simuliert eine Fläche aus Lichtern die in eine Rich-
tung strahlt. Das Licht selbst wird von einer Reihe von Sampling-
Punkten aus dem Light-Icon in die Szene in alle Richtungen 
ausgestrahlt. Dies ist ein sehr diffuses Licht wie aus einer Soft-
box. Der Verwendungszweck ist  z.B. Licht aus einem Fernseher, 
Leuchtstoffröhren etc.

Positionierung, Rotation, Skalierung haben einen Einfluss aufs 
Licht. Skalierung verändert gleichzeitig auch die Intensität des 
Lichtes, da die Sampling-Points Anzahl immer gleich bleibt.

Directional Light

Spot Light

Point Light

Area Light
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Volume Light
Das Volume Light ist ein künstlicher Licht Typ. Mit einem Volu-
me Light, funktioniert es wie ein Point Light, nur das Licht exi-
stiert nur innerhalb der Begrenzung des Light-Icons. Das Licht 
entspricht keiner natürlichen Lichtquelle und wird daher nur für 
bestimmte Special-Effects verwendet.

Position, Skalierung haben einen Effekt auf das Licht. Per default 
wird ein Sphärisches Licht verwendet, jedoch wenn man die Ein-
stellungen verändert wie z.B.. die Begrenzung von Sphere zu Box 
ändert dann hat auch die Rotation einen Einfluss auf das Licht.

Allgemeine Attribute

Color
Alle Lichter haben als Standardwert weiß als Farbe. Jedoch kommt in der Natur eigentlich kein 
Licht reines weiß. Sogar das Sonnenlicht ist je nach Tageszeit, rötlich oder bläulich. Florescent blau, 
Glühbirnen haben einen gelblichen Stich.

Intensity
Dies bestimmt die Lichtstärke wenn sie auf eine Oberfläche auftrifft.

Decay Rate
Die Decay Rate definiert den Abfall der Licht-Intensität von Lampen. Benutzt man keine Decay 
Rate, so ist die Licht-Intensität gleich stark egal wo das Licht auftrifft. Daher ist es ein sehr un-
natürlicher Effect wenn man Lichter ohne Decay Rate verwendet. Mit einer Linearen Decay Rate 
berechnet sich die Intensität an jedem Punkt mit Intensity = 1/Distanz (̂Faktor). Die Qua-
dratic als Faktor 2 entspricht das reale Verhalten von Licht. Cubic ist mit einem Faktor von 3 lässt 
die Licht Intensität schneller abfallen als in der Realität und wird nur in seltenen Fällen verwendet.

In den meisten Fällen reicht es jedoch eine Linear Decay Rate zu verwenden, das verbraucht später 
beim ausrendern weniger Ressourcen und ist eine gute Annäherung an natürliche Lichter. 

Im Allgemeinen benutzt man nicht die Formel um zu errechnen wie das Licht eingesetzt werden 
sollte. Man passt die Intensity und Decay Rate ein paar Mal an und nimmt dann ansprechendste 
Variante. (In vielen Fällen muss man die Intensity drastisch erhöhen, damit man das Licht über-
haupt noch sehen kann).

Im Beispiel ist es das gleiche leicht gelbe Point Light, mit verschiedenen Decay Rate Einstellungen.

No Decay, Intensity 1 Linear Decay, Intensity 5 Quadratic Decay, Intensity 25

Volume Light
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Mit Lichtern arbeiten
Man kann die Lampen in der Szene simulieren wenn man 7 drückt. Alternativ kann man im Pa-
nelmenü auf Lighting > Use All Lights. Wenn man in diesen Modus wechselt und keine Lampen 
in der Szene vorhanden sind, dann werden alle Objekte schwarz dargestellt.

Mit dem „Show Manipulator Tool“ (T), bekommt man zwei Move Handles für das Licht, einen 
um die Position des Lichts zu bestimmen und einen um die Ausrichtung zu bestimmen. Man kann 
zusätzlich  z.B. beim Spotlight durch verschiedene Einstellungsmöglichkeiten wechseln indem man 
auf den kleinen Kreis unter dem Pivot klickt.

Anmerkung: Das Spot Light positioniert man am einfachsten 
indem man das Licht selektiert und dann im Panel Menü auf 
Panels > Look through selected Camera. Das Panel verändert 
seine Ansicht sodass man durch das Licht schaut.

Spot Light mit Show Manipulator Tool

Panel aus Perspektive des Spotlights
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Schatten
Für jede Lampe muss man bestimmen ob sie Schatten wirft. Standard mäßig wirft eine Lampe 
keinen Schatten, man muss ihn immer erst manuell aktivieren. Dies ermöglicht einfacher z.B. eine  
drei-Punkt Beleuchtung, wo nur das Haupt-Licht einen Schatten werfen soll und die anderen Lam-
pen möglichst keinen Schatten werfen.

Es gibt zwei Typen von Schattenberechnung, DepthMap Shadows und Raytrace Shadows. Depth-
Map Shadows sind grundsätzlich schneller auszurendern als Raytrace Shadows. Letztere orientieren 
sich mehr an physikalisch realistischen Gegebenheiten. Man kann für jede Lampe entweder Depth 
Map Shadows oder Raytrace Shadows benutzen. In einer Szene kann man jedoch auch beide Schat-
ten Typen vermischen.

Depth Map Shadows
Bei DepthMap Shadows wird eine DepthMap erzeugt und dann 
mit einem Filter verwischt. Die DepthMap ist im Grunde ein 
Bild aus der Perspektive des Lichtes. In diesem Bild ist die In-
formation gespeichert von der Distanz von Objekten gegenüber 
dem Licht. Beim ausrendern wird dann geprüft ob der Punkt 
eine höhere Distanz zum Licht hat als in der DepthMap, ist das 
der Fall, dann wird er dunkel gemacht. Da dies für jeden Punkt 
wiederholt wird entsteht dann ein Schatten.

Im Grunde gibt es für DepthMap Shadows zwei Variablen - Die 
“Resolution” der DepthMap und die “Filter Size”. Der Filter 
bestimmt den Grad des verwischens. 

•	 Um scharfe Kanten bei den Schatten zu erhalten, erhöht man 
die Auflösung und benutzt einen geringen Filter. (Ein Wert 
von 0 für Filter Size entfernt das Verwischen komplett)

•	 Um weiche Kanten zu erhalten benutzt man eine geringe 
Auflösung und einen großen Filter. (Dadurch das man einen 
unscharfen Schatten erzeugen möchte ist eine hohe Auflö-
sung unnötig. So verkürzt man auch die Rechenzeit für das 
rendern. Falls das zu viele Artefakte erzeugt, muss man die 
Resolution und Filtersize erhöhen).

Das Bias Attribut, kann man in den meisten Fällen auf dem Wert 0.001 lassen, falls Artefakte im 
Schatten beim rendern auftreten sollen kann man den Wert in 0.001 Schritten erhöhen.

Der größte Vorteil von DepthMap Shadows ist, das man die DepthMaps nur einmal erstellen muss 
und man dann die DepthMaps wieder verwenden kann. 

Der Nachteil an dem Verfahren ist jedoch das man keine korrekten Schatten von Transparenten 
Objekten erzeugen kann. 

Generell ist die Verwendung von DepthMap Shadows eher trickreich. Es gibt jedoch speziell für 
Mental Ray eine Alternative Einstellungsmöglichkeit die simpler ist. (Fortsetzung „Mental Ray Sha-
dows“ Seite 52)

Depth Map Shadows Scharfe Kante

Depth Map Shadows Weiche Kante



51Schatten || 

Raytrace Shadows
Bei Raytrace Shadows werden Shadowrays von der Lampe ver-
schickt und dann dementsprechend eingefärbt. Daher können 
Transparenzen korrekt dargestellt werden.

Es gibt bei Raytrace Shadows 3 Einstellungen:

Shadow Radius/Light Radius/Light Angle (je nach Licht Typ 
- Area Light hat keine Einstellungen werden durch die Position 
und Rotation bestimmt) - 0 erzeugt scharfe Kanten - 1 erzeugt 
weiche Kanten.

Shadow Rays  Je höher der Wert desto höher die Qualität der 
Schatten, (desto Höher die Renderzeit)

Ray Depth Limit bestimmt wie oft in einer rekursiven Reflektion ein Schatten sichtbar sind.

Mit Schatten arbeiten
Man kann Panels umstellen, das sie die Schattierung sofort berechnen - ohne das man einen Test-
render erzeugen muss. Man sollte immer erst die gesamte Ausleuchtung der Szene fertig haben und 
dann diesen Modus aktivieren. 

Hierfür aktiviert man im Panelmenü Lighting > Shadows

Dies sollte man wieder deaktivieren wenn man modelliert/animiert, da ansonsten Maya sehr lang-
sam reagiert beim manipulieren von Objekten.

Raytrace Shadows
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Light-Rig
Ein Light-Rig wird verwendet um verschiedene Beleuchtungsszenarien mehrfach zu verwenden. 
Dies erspart einem für jede neue Szene die Gesamte Beleuchtung neu einzustellen.  Ein weiterer 
Vorteil ist das man mehrere verschiedene Modelle hinweg das gleiche Erscheinungsbild wahrt.

Die Limitation von diesem Verfahren ist das es nur dazu dient 
einzelne Modelle auszuleuchten. Für eine Animation braucht 
man seine eigene individuelle Umgebung und Beleuchtung.

Backdrop
1. Zu der SideView wechseln

2. Create > CV-Curves mit x-gedrückt 
die Kurve zeichen (siehe Bild)

3. Duplizieren (STRG-D) und Transform (TranslateX = 12)

4. Surfaces > Loft

5. Wechsel des Maya-Modus  auf Rendering (F6 oder 
über das drop-down menü) Lighting/Shading 
> Assign new Material> mia_material_x

Anmerkung: Im Marking Menu des Lofts (RMB auf den Loft) 
gibt es auch den Befehl. Man kann sich so einen Wechsel zwi-
schen Modulen sparen. 

Schritt 2: Curve

Schritt 4: Fertiges Loft
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6. Im Attribute Editor auf mia_material_x1 wechseln - hier sollte 
man das Material umbenennen auf backdrop_material.

7. Unter Presets das Material MatteFinish > Replace auswählen

Anmerkung: Das Material mia_material_x is generell ein metallisches Material. In diesem Fall 
mit dem Preset MatteFinish, ist es ein Diffuses nicht reflektierendes Material - Ideal herzunehmen 
als Studio Hintergrund. 

8. Man kann nun über die diffuse Einstellungen die Farbe ver-
ändern über die Color Eigenschaft z.B. in Weiss.

9. Das Loft auf seine Eigene Ebene “Backdrop” setzen.

Studio Lighting: Softbox
Eine Softbox ist ein flächiges Licht was sanft die Umgebung beleuchtet. Eine Softbox hat eine be-
sonders Markante Rechteckige Form in der Reflexion. 

AreaLight
Die Lichtquelle die am nächsten einer Softboxbeleuchtung 
kommt ist das Arealight.

1. Create > Lights > Arealight

2. Im Attribute Editor:

 - Farbe zu einem hellen Gelb (HSV - 60, 0.1,  1)

 - Intensity = 15 und DecayRate auf Linear

 - Schatten einstellen (z.B. Raytrace Shadows Shadow Rays 35)

 - Unter Mental Ray - Area Light - Use Light Shape aktivieren  
 und High Samples auf 32 setzen

3. Das Licht mit dem Show Manipulator Tool (T) positionieren auf  Translate 
(10,5,10) und auf den Ursprung ausrichten mit dem 2. Move Manipulator

4. Das Licht duplizieren (STRG-D) und TranslateX -10

5. Die Lichter auf eine eigene Layer „Two_Softboxes_Arealights“

Schritt 5: Marking Menu on Loft Schritt 6-7: Attribute Editor vom für das Material

Beispiel einer Softbox Beleuchtung
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Area Softbox Beleuchtung

Area-Spotlights
Als Alternative wenn man ein Area-Spotlight verwendet kann 
man die Prenumbra Eigenschaft einfacher und genauer bestim-
men. Jedoch würde die Reflexion von der Area-Spotlight rund 
werden.

1. Create > Nurb Primitives > Pla-
ne (Width = 4, RotateX = 90)

2. RMB auf der Plane > As-
sign new Material > Surface Shader

3. Den Surface Shader ColorOut auf Weiss setzen.

Anmerkung: Der Surface Shader ist ein Materialshader, der nur eine Farbe als Eigenschaft hat. 
Im Grunde ist dieses Material immer einfach nur die Outputfarbe und hat keinerlei andere Eigen-
schaften. Dies ist optimal fuer die Softbox da sie eigentlich nur  eine Lichtquelle ist ohne jegliche 
Eigenschaften.

4.  Create > Lights > Spotlight

5. Im Attribute Editor:

 - Farbe zu einem hellen Gelb (HSV - 60, 0.1,  1)

 - Intensity = 15 und DecayRate auf Linear

 - Cone Angle = 60 (Streuwinkel der Lampe

 - Prenumbra = 20 (Abfall der Lichtintensität - hohe Werte ergeben eine Weiche Kante)

 - Schatten einstellen (z.B. Raytrace Shadows Shadow Rays 35)

 - Unter Mental Ray -  use Area Light aktivieren und die beiden High Samples auf 32 setzen.

Anmerkung: Man hätte auch direkt eine AreaLight erzeugen können, dies jedoch ermöglicht kei-
nerlei Einfluss auf die Prenubra Eigenschaft.

6. Erst die Plane auswählen und dann das Licht und 
dann Edit >Parent (P) (Dies bewirkt das sich die 
Plane automatisch mitbewegt mit der Lampe)

7. Die Lampe kann man nun positionieren wo man 
will. Am einfachsten hat man es wenn man die An-
sicht im aktiven Panel auf Panel >Look Through 
Selected stellt. Bewegt man im Modus “Look 
through Selected” die Kamera so bewegt sich tatsäch-
lich das Objekt was man zuvor ausgewählt hat. 

Anmerkung: Drückt man die Taste 7 (Use All Lights) schaltet man alle Lichter ein und man sieht 
grob wie was beleuchtet wird.

8. Nachdem man die erste Kamera positioniert hat, kann man zurück wech-

Plane mit Lanpe
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seln in die normale perspektiven Ansicht indem man über das Menü, Panel 
> Perspektive > persp, oder über die Hotbox (Leertaste länger gedrückt hal-
ten), in der Mitte mit der linken Maustaste nach oben zieht, benutzt. 

9. Nun kann man die Softbox duplizieren (STRG-D) und wieder positionieren.

10. Die beiden Softboxen nun auf eine eigene Layer “Two_Softboxes_AreaSpotLights” setzen.

Outdoor Lighting

Das Lightrig kann nun mit weiteren Layern mit anderen Beleuchtungssituationen ausgestattet wer-
den.

Verwendung des Light-Rigs:

Beispiel: Bauhaus-Stuhl
1. Man öffnet das Lightrig und File speichert es als neue Da-

tei “bauhaus_render.mb” (File > Save As)

2. File > Import  “bauhaus.final.mb”

3. Den Stuhl plaziert man auf dem Backdrop so dass er gut beleuchtet ist.

4. Der Stuhllehne weist man ein “mia_material_x” mit dem Preset Chrome zu.

5. Der Sitzfläche gibt man ein weißes Phong Material

6. Create > Cameras > Camera und wählt einen Bildausschnitt

7. Rendern


